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 5 

SUPPLEMENTAL EXPERIMENTAL PROCEDURES 6 

EpiGraph Source code. 7 

The project’s code is accessible through Github 8 

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph. It is open 9 

source and available under GPLv3 license. 10 

Pipeline.  11 

The image processing pipeline entails cell recognition, valid cell identification, 12 

graph of cell-cell contact creation, polygon distribution analysis and, finally, 13 

GDDH, GDDRV and GDDV5 calculation. These stages are properly described in 14 

the subsequent paragraphs. In addition, a full set of tutorials explaining how to 15 

install and use EpiGraph are available at EpiGraph’s wiki 16 

(https://imagej.net/EpiGraph). In addition, Movie S1 summarizes a general 17 

example with default options. 18 

 19 

- Recognition of existing cells 20 

EpiGraph uses segmented images from natural tissues or simulations as an 21 

input. These images must be built in binary format, where one colour should be 22 

presented as the background, forming the body of cells, and the other one the 23 

cells outline. Each cell is assigned a label using MorphoLibJ (Legland et al., 24 

2016). This identifier allows us to have a record of every cell and its location on 25 

the image, which is necessary for the following steps. 26 

- Identification of valid cells 27 

Once we have properly labelled the image, we proceeded to fully analyse it. By 28 

default, an invalid region is created, which is initially defined by the boundaries of 29 
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the image itself. We select all the cells that fall outside of this border and set them 1 

as non-valid cells (note that non-valid cells are different from invalid regions, i.e. 2 

the latter are not cells). In this way, we avoid incorrect characterization of polygon 3 

distribution due to the lack of real neighbours in the margins of the image. 4 

However, it is also possible to create a personalized invalid region, by selecting 5 

as many cells as you want. 6 

In addition, we define another two kinds of valid cells: the 4’ valid cells and the 7 

5’ valid cells. The former represents the cells that do not have a non-valid cell 8 

within a distance of four cells connexions. The later kind is formed by the cells 9 

having all valid cells in a maximum length of five cells connexions. Mo7 and Mo10 10 

require 4’ valid cells and Mo17 and Mo29 5’ valid cells. 11 

- Neighbourhood creation  12 

An epithelium can also be considered as a tessellation because there is no 13 

space between each cell.  Thus, inspecting the number of sides of the cells, we 14 

can measure the number of neighbours that will surround it. We, therefore, extend 15 

a mask from each pixel of the cell with a given shape and size, both selected by 16 

the user. Then, we capture all the cells distinct from the actual cell that fall into 17 

this mask and add them as neighbours of the concrete cell. Afterwards, we create 18 

a neighbourhood network, modelling each cell as a node and connecting two cells 19 

with an edge if they are neighbours. 20 

- Polygon distribution analysis 21 

The polygon distribution is defined by the number of sides of every valid cell. 22 

We specify three different areas: the global zone formed by all valid cells, the 23 

region in which 4’ valid cells are contained and the territory in which 5’ valid cells 24 

are placed. For Mo7 and Mo10, we use a path of length 4 (4’ valid cells as orbits 25 

nodes, and valid cells as its branching nodes), and for Mo17 and Mo29 the area 26 

is defined by the cells contained within the path of length 5 (5’ valid cells as orbits 27 

nodes, and valid cells as its branching nodes). Finally, we calculate the polygon 28 

distribution regarding the cells involved in the graphlet calculation. 29 
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- GDDH, GDDRV and GDDV5 calculation 1 

We have adapted Graphlet degree Distribution agreement Distance (GDD) from 2 

Yaveroğlu et al. (Yaveroğlu et al., 2014) to fully integrate it with FIJI java 3 

environment. We use GDD to compare two images and describe how similar they 4 

are. In particular, minimum distance value (0) means two images are equal, and 5 

maximum distance value (1) specifies that they are very different in terms of 6 

graphlets. We compute all the graphlets in which the valid cells participate. Then, 7 

we use only the graphlets in which 4’ or 5’ valid cells are included (depending on 8 

the set used). We defined three references to compare with the real images. The 9 

first one is the Graphlet degree Distribution agreement Distance Random Voronoi 10 

(GDDRV). A random Voronoi (RV) emerges from 500 seeds randomly placed. 11 

Then, we computed the GDD between each one of the 20 RV images and the 12 

input image and used the mean of these 20 GDDs as final distance. We also 13 

calculated the Graphlet degree Distribution agreement Distance Hexagons 14 

(GDDH), which measures the difference between a given image and a regular 15 

tessellation of hexagons, in a similar way to the GDDRV. Finally, we computed 16 

the Graphlet degree Distribution agreement Distance Voronoi 5 (GDDV5) by 17 

comparing a given image with 20 diagram 5s from the CVT path and calculating 18 

its mean. 19 

- Statistical analysis 20 

Right before adding all the GDD values to the table, we performed a statistical 21 

analysis (see Experimental procedures, statistical analysis) to calculate the 22 

closest diagram on the CVTn. This test provides a confidence score determining 23 

if the source image is part of the CVTn path of reference or, on the contrary, is 24 

an outlier. 25 

Graphical user interface. 26 

ImageJ’s FIJI distribution (Schindelin et al., 2015, 2012) provides a framework, 27 

which offers a range of functions and a suitable predefined application 28 

programming interface (API). Furthermore, it allows users with no programming 29 

expertise to execute and exploit all their functionalities. EpiGraph is prepared for 30 

heavy processes. In these cases, some operations such as “calculate graphlets”, 31 
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run in the background, giving the user the possibility to move around the 1 

application smoothly. In addition, a progress bar displays the evolution of the task 2 

in case it may take longer than expected. FIJI works on the three main Operative 3 

Systems (Linux, Mac and Windows) without requiring Java installation since it is 4 

usually embedded in the program. FIJI describes different ways it can be 5 

operated by external software. One of them is constructing a plugin, which is used 6 

by EpiGraph as basic structure to start building. Using Java Swing GUI libraries, 7 

we have designed the three windows of the EpiGraph plugin.  8 

- Main Window 9 

The program starts after clicking on Plugins>EpiGraph. The first window that 10 

appears is the Main Window. It contains a table of processed images (therefore, 11 

initially it is empty). Each table row corresponds to a single processing of image 12 

and comprises the following columns: Colour, label, GDDH, GDDRV, GDDV5, 13 

percentage of hexagons, radius of shape, type of shape, kind of graphlet 14 

calculation, closest diagram, confidence score and a checkbox. Colour column 15 

lets you pick the colour of the point from the palette to be visualized later; Label 16 

shows the name of each image; GDDH, GDDRV and GDDV5 represent the GDD 17 

of the image against hexagons, random Voronoi diagrams and Voronoi 5 18 

diagrams from CVTn, respectively; Percentage of hexagons contains the 19 

proportion of hexagons for all valid cells involved in graphlet calculation; Radius 20 

specifies the shape size used to calculate neighbours; Shape characterizes the 21 

type of form used to calculate neighbourhood; Kind of calculation displays which 22 

set of graphlets was used; Closest diagram represents which number Voronoi 23 

diagram from the CVTn is closest to the image; Confidence score is the certainty 24 

of the image being an inlier of the point cloud of that diagram. Finally, Select 25 

column lets you choose, by means of a check box, whether you visualise the 26 

calculated data in a 3D viewer or not, and in the same way, removes the selected 27 

rows if you click on the button remove rows. Additionally, you do not need to 28 

calculate the graphlet properties every single time. Instead, it is possible to import 29 

your own dataset from a properly formatted Excel file, using the import table 30 

button. Likewise, once you have already analysed several images, you can 31 

export your information into an Excel file, using the export table button. The 32 
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exported table includes the polygon distribution of the cells involved in the 1 

graphlets calculation. Lastly, you have the option of representing all table rows, 2 

by ticking the “true” check box. For that, you should click on the visualize button 3 

to launch the mentioned 3D viewer. 4 

- Image processing Window 5 

This window will be automatically triggered when a supported file format is 6 

correctly selected, after clicking the open main window button. This window is 7 

composed of a button panel with different processing options, a canvas with the 8 

loaded image embedded in it and a polygon distribution legend. The only enabled 9 

button when the window is first opened, will be the mode in which you label the 10 

image. You can choose to label this image using either 8-connectivity or 4-11 

connectivity and then click on the label image button to execute it. After these 12 

other buttons become enabled. These buttons are classified in 3 panels:  13 

• Region of interest. The main objective of this panel is selecting regions of 14 

interest so that only valid regions are processed and invalid ones are 15 

discarded. The create ROI and select cells buttons let you select various 16 

rectangular (default) regions and pick individual cells using the FIJI’s ROI 17 

manager tool. You can repeatedly combine both options to establish a 18 

valid region in which to operate. Furthermore, you can change the ROI 19 

selection shape, from rectangular to another shape, using FIJI’s control 20 

panel. On the other hand, there is the option to choose an invalid region 21 

by clicking over it, after clicking the add invalid regions button. This action 22 

only lets you store a single set of invalid ROIs at a time, so if you wanted 23 

to add an invalid region after saving previous invalid regions, you must 24 

delete the former to include a new one. 25 

• Neighbourhood. This panel allows you to visualize valid and non-valid 26 

cells, invalid regions and polygon distribution values from the current 27 

image. To calculate the neighbourhood you should select, using the 28 

number selector (located close to radius), a size of shape in pixels and a 29 

specific geometrical shape using the tool described above (located next to 30 

shape). This selection depends on the width of the cell outline. If the border 31 

cells have a width of 1 pixel, it is enough using a size of 3 pixels to explore 32 
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the cells vicinity. By default, we expand 3 pixels each cell, using the 1 

circular shape, to look for their neighbours. For wider border cells, you can 2 

choose higher size of mask with either circular or squared shape. Once 3 

the parameters have been selected, the test neighbours button can be 4 

pressed to calculate the neighbourhood for the valid cells belonging to the 5 

ROI. If the ROI is the whole image, a column next to the legend of polygons 6 

shapes, headed by “Graphlets”, would be filled with the polygon 7 

distributions of the valid cells. Otherwise, if the ROI is a subsection of the 8 

image, a new column appears next to “Graphlets” headed by “ROIs” that 9 

will be filled by the polygon distribution of the valid cells belonging to this 10 

ROI. Note that in this case, the “Graphlets” column would be filled with the 11 

polygon distribution of the all valid cells participating in the ROI graphlets 12 

calculation.  13 
Finally, when the columns are filled, an overlay is displayed on the canvas, representing 14 
each cell colour coded by polygon number. These colours are the same that the ones at 15 
the legend located at the left of the window. In addition, the toggle overlay button 16 

lets you choose whether to visualize the overlay created by test 17 

neighbours. The invalid regions and the cells outlines are labelled in black 18 

in the overlay, dark grey marks non-valid cells, and the rest of colours 19 

(represented in the polygon distribution legend) are reserved for valid 20 

cells. It is important to highlight that the bright colours of the legend 21 

displayed over the canvas represent the number of sides of the valid cells 22 

into the ROI. The same pale colours represent the polygon distribution of 23 

valid cells located out of the ROI, yet which still contribute to the graphlet 24 

calculation of cells within the ROI. A 5’ valid cell is a cell that do not have 25 

a no valid cell within a distance of five cells connexions. Moreover, a 4’ 26 

valid cells have no valid cells in at least three branched cells.  27 

• Graphlets. This panel is designed with the aim of saving graphlet data 28 

internally and externally. There is a text box where you can add the data 29 

label (image name by default), located after image label text. You can also 30 

select a colour label for your data, using pick a colour button. Finally, you 31 

can choose the appropriate method to calculate graphlets data. The 32 
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options are: 26 graphlets representing 29 cellular motifs (Mo29), 17 1 

graphlets that are contained in 17 cellular motifs (Mo17), 9 graphlets on 2 

behalf of 10 cellular motifs (Mo10) and 7 graphlets typifying 7 cellular 3 

motifs (Mo7). Mo7 and Mo10 are formed by graphlets of maximum 4 4 

nodes, while Mo17 and Mo29 make use of graphlets of maximum 5 nodes. 5 

Mo7 and Mo10 are most useful when images have a small number of cells, 6 

since both require fewer cells than Mo29 and Mo17. Once the method has 7 

been selected, you can then click the calculate graphlets data button to 8 

acquire data for all calculated graphlets. When this process is complete, 9 

data are automatically added to the main window table. Furthermore, by 10 

clicking on Export Graphlet data you can export a ZIP file containing: a 11 

JPG image representing the neighbourhood, another JPG image 12 

capturing the label of the cells, a CSV file storing all calculated graphlet 13 

data and a .sif that represent the neighbourhood network. 14 

The window has a progress bar that estimates the process state. You can 15 

modify the image zoom by pressing control and rotating the mouse wheel at same 16 

time. 17 

- Visualizing Window 18 

We use a 3d viewer to display our calculated results stored in the main window’s 19 

table. When a row´s checkbox is ticked, it will be plotted. To develop this window, 20 

we have used an open source library named Jzy3D (http://www.jzy3d.org/) that 21 

is able to generate different graphical representations. In particular, we make use 22 

of the 3d scatter plot class. 23 

 This window is displayed after clicking on the visualize button (located in the 24 

main window), even if your table is still empty. This window is composed of the 25 

scatter plot figure located on the left and a set of components to modify the 26 

appearance of this figure on the right. The plotted figure is delimited by a 3D box 27 

with 3 axes: Percentage of hexagons, GDDH and GDDRV by default. These 3 28 

axes can be replaced by any of the following configurations (𝑋 − 𝑌 − 𝑍 axes) 29 

using the drop-down list with the label Axes of figure (upper right corner of the 30 

window): 31 
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1- GDDH-GDDRV-Percentage of hexagons (default) 1 

2- GDDH-GDDRV-GDDV5 2 

3- GDDH-GDDV5-Percentage of hexagons 3 

4- GDDRV-GDDV5-Percentage of hexagons 4 

The Percentage of hexagons axis encapsulate values between 0 – 100, and the 5 

others between 0 – 1. These limits can be modified for zooming in on the 6 

individual axes. We used three rangeSliders to select the range for each axis to 7 

be represented due to the limitations of the Jzy3D library. This library only 8 

provides you the possibility of zooming the 𝑍 axis turning the mouse wheel. You 9 

can visualize the three rangeSliders (one per axis) just below the Axes of figure 10 

drop-down list. 11 

By default, the scatter plot displays the CVTn path, shown as individual dots: 12 

The darkest dot represents the average of 20 Voronoi diagrams 1 in CVTn and 13 

the lightest one is the average of 20 Voronoi diagrams 700 in CVTn. You have 14 

the option to disable the visualization of these references clicking on the 15 

checkbox ‘Show reference’ (just below rangeSliders), to only display calculated 16 

data. One can also adjust the size of the dots by modifying the position of the 17 

slider bar, located just below the previously mentioned checkbox. To select the 18 

different modes in which graphlet data of the CVTn reference can be calculated, 19 

a drop-down list can be deployed by clicking on the label Motifs of CVTn 20 

reference. This list allows you to represent the CVTn path depending on the 21 

method with which the graphlets were calculated: Mo29, Mo17 (by default), Mo10 22 

and Mo7.  23 

The dots shown in the figure in the Main Window can be modified by changing 24 

the colour box in the Main Window’s table. In addition, a .png figure screenshot 25 

can be saved, by pressing the Export view button. For more detail, different 26 

angles and modes of visualization are available. By clicking the figure and moving 27 

the mouse, one can change the viewing angle, while double clicking on the figure 28 

will automatically perform a 360 degrees’ rotation. 29 

Functionalities. 30 

Along the program execution pipeline, there is the opportunity to develop a set 31 

of functionalities: 32 
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- Label image 1 

Once you have selected an image to process, this image is binarized and the 2 

background is analysed to detect the cells and their outlines. If the number of 3 

white pixels is higher than black pixels, white pixels will be considered as cell’s 4 

body, and vice versa. After that, each cell’s body region of the image is assigned 5 

with a unique label. Thanks to the extensible architecture of FIJI, in which you 6 

can install plugins to add additional functionalities, this process of labelling 7 

regions is made using MorphoLibJ functionalities. Specifically, we have used the 8 

connected component labelling, which transforms a binary image into a labelled 9 

one by assigning a specific number to each connected component. 10 

- Create ROI 11 

Though it is possible to analyse the entire image, you can also process a smaller 12 

region of interest (ROI). Through FIJI’s Roi Manager we can manage the ROIs, 13 

saving and performing operations on one at a time. We have selected two default 14 

operations within EpiGraph: rectangle (or any available shape) and multipoint 15 

selection. The former creates a rectangle selection (by default) and defines all 16 

the cells that fall inside it as valid cells. The latter enables the multipoint function 17 

with which it is possible to select individual cells. However, it is also possible to 18 

change these default forms of selection, by going straight to FIJI’s main window 19 

and picking any from the toolbar. 20 

-Select invalid regions 21 

As your image may contain artefacts in the form of false valid cells, we have 22 

made it possible to mark these zones as invalid regions. All valid cells 23 

surrounding the mentioned invalid region will be considered as “non-valid cells”. 24 

It is possible to select several areas of the image using the multipoint tool, to 25 

convert them to invalid sections. To validate this action, the selected invalid 26 

region should have the same colour as the cells’ background. 27 

- Testing neighbours 28 

As mentioned the previous section, EpiGraph is able to calculate the polygon 29 

distribution using 2 essential parameters: a given pixel radius and an element 30 

shape. The element shape expands to a given radius of the cells of interest, 31 

looking for cells neighbouring. To ensure that the neighbourhood is correctly 32 
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captured, we allow the users to verify if the image has the right parameters by 1 

themselves. The polygon distribution of the image will appear with numbers at 2 

the left side of the window and each cell will also be painted with a colour 3 

representing its number of sides. Additionally, non-valid cells are coloured dark 4 

grey (almost black). Depending on the method chose to calculate graphlets 5 

(Mo29 or Mo17 considering 5’ valid cells; Mo10 or Mo7 considering 4’ valid cells), 6 

the zone coloured with bright colours will be established only by a group of central 7 

cells. In the same way, when we select a ROI, the cells affecting the cells within 8 

the ROI will be represented in pale colours. Furthermore, due to the variant 9 

number of 4’ and 5’ valid cells that are going to be filling the ROI, you may 10 

encounter when a series of particularities: 11 

o Some cells of your defined ROI could not be final valid cells (4’ or 5’). If 12 

the ROI is not surrounded by a minimum of 4 cells in all directions, the 13 

number of 5’ valid cells is going to be lower than the number of 4’ valid 14 

cells. Thus, if you select Mo17 or Mo29, some cells will not be 5’ valid 15 

cells and will not be used in the final graphlet computation as principal 16 

nodes. 17 

o An empty ROI. If you select a region with no 4’ or 5’ valid cell, you will 18 

obtain an empty neighbourhood. 19 

o The pale coloured cells affecting the 4’ or 5’ valid cells will differ, when 20 

switching from Mo17 to Mo7 (for example). Therefore, a different number 21 

of cells will be affecting the bright coloured cells. 22 

Finally, the calculations for neighbourhood will be exploited by calculate 23 

graphlets module, if parameters are not modified since this step. 24 

- Calculate graphlets 25 

The main function of EpiGraph is the graphlet comparison. It begins by checking 26 

if there are any selected cells or ROIs. Then, in case any configuration has 27 

changed, we re-compute the neighbourhood, otherwise we take the information 28 

from a previous computation. From this neighbourhood and valid cells, it 29 

calculates the graphlets for the involved network of neighbours. As mentioned in 30 

previous sections, it would be incoherent not to filter the graphlets, so we refine 31 
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it by adding only the nodes at a fixed distance from the border nodes to the final 1 

graphlets. We first calculate the total set of graphlets for valid cells and then select 2 

a filter that depends on the chosen type of Graphlets to be implicated: Mo29 (26 3 

graphlets), Mo17 (17 graphlets), Mo10 (9 graphlets) and Mo7 (7 graphlets).  The 4 

involved orbit nodes for graphlet calculations will be referred as 4’ and 5’ valid 5 

cells. When we have the final graphlets, we calculate the three distances (GDDH, 6 

GDDRV and GDDV5). Depending on the number of graphlets selected, a variable 7 

number of orbits are used in the comparison. Finally, the results will be added 8 

automatically to the table on Main Window.  9 

- Statistical analysis 10 

  Once all GDD data from an input image have been calculated, a statistical 11 

analysis is carried out to check if the GDD values of a certain image matches with 12 

the CVTn scale or if the image is out of the CVTn path in terms of organization. 13 

First, the closest CVTn diagram to the image is computed, estimating the 14 

Euclidean distance by considering 3 dimensions: GDDH, GDDRV and GDDV5. 15 

Thereafter, it is checked whether the image could belong to the closest diagram 16 

CVTn point cloud. At this point, the method generates a confidence score for the 17 

comparison to the CVTn (see Experimental procedures, statistical analysis). 18 

The closest diagram and the confidence score are computed and added to the 19 

main window table immediately upon calculating the GDD values or importing 20 

from an existing excel document. Alongside these two parameters, when 21 

exporting to an excel, the Euclidean distance to the closest diagram is also 22 

presented as a column. 23 

- Visualization 24 

Visualizing results properly is a major feature and an important challenge to 25 

interpret results. Thus, we have embedded Jzy3d chart in a Java JDialog where 26 

you can visualize the calculated results’ three coordinates (any combination of 27 

GDDH, GDDRV, GDDV5 and percentage of hexagons) as a point in a scatter 28 

plot. Once the points are represented you can compare them with our CVTn 29 

reference. At this point, you may want to change the illustrated CVTn selecting 30 

the number of graphlets used on the computations, although it is advisable to 31 
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compare images with the same configuration (Mo7, Mo10, Mo17 or Mo29). 1 

Additionally, it is possible to increase or decrease the size of the dots and zoom 2 

each axis manually. Finally, you can export the actual view of the chart to an 3 

image file. 4 

Dependencies. 5 

FIJI is designed to add functionalities via several routes, one of which is Plugin. 6 

In order to have simple control of dependencies and project settings, it uses 7 

Maven. Maven is a tool that is broadly used for supervising and building Java-8 

based projects. It integrates several tools, such as Javadoc, to make all the 9 

programming steps easy. Dependencies are downloaded and updated when 10 

available. Furthermore, it helps you create the package with all your code and 11 

zips it in a .jar file that will be the Plugin format of FIJI.  All this is achieved through 12 

its project object model (POM), which you can shape to your project adding 13 

mailing lists, issue tracking and more. 14 

Supported file formats. 15 

EpiGraph’s input is an image. This image should be properly segmented and 16 

grey-scale, however, there are several options within EpiGraph to configure it 17 

depending on the type of the image. We allow images with different sizes of 18 

borders, since it is possible to increase the radius of the mask, changing the way 19 

in which the neighbourhood is built. However, it is mandatory that images are 20 

binary images (8 and 32 bits RGB images can be loaded, but they might not be 21 

correctly computed), where one colour is presented as the background, forming 22 

the body of cells, and the other the cells outline. Regarding the image file 23 

extensions, we entrust FIJI with the image opening and the supported files, so 24 

individual image file extensions allowed by FIJI would be supported in EpiGraph. 25 

We cannot admit any sequence of images and single images with high resolution 26 

due to problems with complexity in EpiGraph processing tasks. Accordingly, we 27 

limit the maximum of 3000px to either height or width of the image, to allow 28 

correct execution of the program. 29 

Quick step-by-step EpiGraph’s usage. 30 
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- Installation 1 

Through FIJI/ImageJ update site: 2 

The usual way to install a FIJI plugin is through his on-site updater. It’s usually 3 

located on “Help > Update FIJI”. Once it is open, you click on “Manage updates 4 

sites”, look for EpiGraph and tick the checkbox next to it. Finally, “Apply changes” 5 

and you should have successfully installed this plugin. With this option, you can 6 

automatically get the latest version of EpiGraph. 7 

Manually: 8 

On the other hand, you may just want to download the .jar file from 9 

https://tinyurl.com/EpiGraph-1-0-1 (or even generate your own .jar from source 10 

code) and install it manually. To do this, you can click either Plugins>Install or 11 

Plugins>Install PlugIn. Then you select the provided .jar and you should be able 12 

to run EpiGraph. 13 

- Simple example of a complete analysis 14 

Calculate GDDH, GDDRV, GDDV5 and percentage of hexagons from a given 15 

image and visualize it in the 3D visualizer.  16 

1. Select open. 17 

a. Select a supported image. 18 

b. If the image is supported, a window with the image will open. 19 

2. Pick connectivity: 20 

a. Select the connectivity of your image. Usually 8-connectivity. 21 

b. Press label. 22 

3. Default configuration: 23 

a. Radius of 3 pixels. 24 

b. Circle shape. 25 

4. Calculate graphlets and statistics: 26 

a. Write a name for your image. 27 

b. Pick a colour for your image. 28 

c. Select Mo29 in the combo box (26 graphlets). 29 

d. Press calculate graphlets. This will calculate GDDH, GDDRV and 30 

GDDV5. 31 
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e. When GDDs have been calculated, a statistical analysis is carried 1 

out providing a confidence score and the closest CVTn diagram to 2 

the image. Once it is finished, if the name box is not empty, all data 3 

will be automatically added to the main window table. 4 

 5 

5. Export graphlets data: 6 

a. Press the Export graphlets data button. 7 

b. EpiGraph create a zip folder containing several files; an image with 8 

all the cells labelled with their corresponding identifier, another 9 

image representing the polygon distribution and, finally, a ‘.csv’ file 10 

with the graphlets for all the valid cells. 11 

6. Visualize your results: 12 

a. Return to the main window. 13 

b. Click on visualize. 14 

7. Export view: 15 

a. Staying in the visualizing window, you have the option of exporting 16 

the actual view into a ‘.png’ file at every stage. 17 

b. Press export view. 18 

Congratulations! You have done the complete pipeline. Now, check where your 19 

image is in regard to the CVTn scale. You should analyse whether or not your 20 

image is near the CVTn (reference), which can be done using its closest diagram 21 

and confidence score from the table. 22 

- Create region of interest 23 

If you wish to test a sub-region of your images, you can create a region of 24 

interest (ROI). We have already opened an image and labelled it within EpiGraph. 25 

1. In the image processing window: 26 

a. Press Create ROI. 27 

b. The default ROI is square shaped; however, you may want to test 28 

another shape. You can now return to the FIJI application and 29 

select any of the existing ones on the toolbar. 30 

c. Click done. Your ROI is managed and stored in FIJI Roi Manager. 31 
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You have created your ROI; however, you cannot see how it affects the image 1 

yet.  2 

2. Press Testing neighbours: 3 

a. An image representing each cell by its number of neighbours 4 

will appear as an overlay in your image. Remember that the valid 5 

cells in the ROI, which appear with intense colour, are the 4’ or 5’ 6 

valid cells (depending on your graphlet selection), and the pale 7 

colours represent the rest of valid cells that affect the computation 8 

of graphlets. The result will be represented in the polygon 9 

distribution legend. 10 

 11 

Once this procedure has been accomplished, you can continue the execution in 12 

the same way as before: graphlet calculation and statistics, export of results and 13 

visualization. 14 

- Combine ROIs 15 

As regions of interest are managed by the ROI manager you can add several 16 

ROIs to the image. You have already opened the image and properly labelled it. 17 

1. Press Create Roi: 18 

a. Select a left-hand region with the rectangular ROI shape. You 19 

should not select any of the cells on the right-hand side yet. 20 

b. Done. 21 

2. Select individual cells: 22 

a. Click Select cells. 23 

b. Pick only cells on the right-hand side of the image. 24 

3. Test your setup: 25 

a. You should be able to see the cells that fall into both ROIs. 26 

b. Press test neighbours. 27 

4. Oh! You realize you have made a mistake: 28 

a. You do not want the first ROI. 29 

b. Go to the ROI manager. 30 

c. Select the first ROI and click Delete. 31 

5. Test the new selection: 32 
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a. You will now represent only the existing ROI on the right. 1 

b. Click test neighbours again. 2 

If you create some ROIs, the selected cells will be all the cells that fall into any 3 

of the ROIs. The logical operation would be an OR, so ROIs could be 4 

disconnected. 5 

- Selection of the number of motifs 6 

There are 4 possible configurations. In this example we will create an analysis 7 

with Mo29 using 26 graphlets. 8 

1. Open an image representing cells with 4-connectivity and borders with 1-9 

pixel width. 10 

2. Label it: 11 

a. Click label. A warning notice advises that there are very few cells in 12 

the image. Your full image is tagged with the same label because 13 

all the cells are connected.  14 

b. Select now 4-connectivity. 15 

c. Click label. That works as expected! Each cell has a different tag. 16 

3. Test neighbours by default. 17 

4. Mo29: 18 

a. This configuration has the maximum number of graphlets present 19 

in our study. 20 

b. Change the combo box to Mo29 (26 graphlets). 21 

5. Calculate graphlets: 22 

a. Add a proper name to your image. 23 

b. Press calculate graphlets to add the full results to the table. 24 

6. Visualizing: 25 

a. Change the colour of your row to a pink-ish colour. This will let you 26 

differentiate your data from the reference, which is black, grey and 27 

almost white. 28 

b. Click on Visualize. 29 

c. As a default, your reference is Mo17 (17 graphlets). So, change this 30 

option in the combo box to Mo29 (26 graphlets). 31 

d. Modify the axes of figure to ‘GDDH-GDDRV-GDDV5’. 32 
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e. Change the range sliders at your right side to get an adjusted 1 

visualization per axis. 2 

You will see that the reference has changed regarding the default Mo17(17 3 

graphlets) reference. Your image is probably aligned to the CVTn reference. This 4 

is because your image is within the CVTn path, otherwise the image organization 5 

would be different to our model of reference. You can verify this with the 6 

confidence score, which also provides the closest diagram to the input image. 7 

- Increase the radius of neighbourhood. 8 

You have a segmented image with a border wide of 3 pixels, and you want to 9 

capture the real number of neighbouring of each cell. You have already opened 10 

the image and properly labelled it.  11 

1. Test if neighbours are correct: 12 

a. Since you do not know which pixel radius you should select, test 13 

various shapes and radii in order to see if the cells with 6 14 

neighbours are actual 6-sided cells. 15 

b. Change parameters and click on test neighbours to make sure the 16 

neighbourhood is correct. 17 

Once your polygon distribution is correct enough, you can follow the next step 18 

of the analysis protocol. 19 

 20 
- Import/export table 21 

You may want to save your results and to do this you can export your results to 22 

an excel file, simply by pressing the button export in the main window.  23 

On the other hand, if you would like to continue your session right where you 24 

left off, you could import your exported excel file to the table and carry on with 25 

your analysis. You can add as many .xls files to the table as you want and we 26 

allow duplicates. If you want to remove them, just tick them at the Select all 27 

column and click on Delete rows. 28 

Another option is to calculate the mean values of a particular set of images 29 

outside EpiGraph. To do this, import the excel with the mean values. EpiGraph 30 
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will automatically calculate all the values of the closest diagram and its associated 1 

confidence score, enabling you to improve your analysis on that dataset. 2 

 3 

Troubleshooting 4 

If the visualization is not working properly, you may need to update FIJI after 5 

the installation. 6 

If you find something is not working with any functionality of the application, you 7 

can send an e-mail to pvicente1@us.es or pgomez-ibis@us.es. Reporting bugs 8 

can also be done through Github 9 

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/issues. Known 10 

issues are held at the same page. 11 

 12 

License Information. 13 

To encourage the sharing of resources, EpiGraph is published under an 14 

open-source (GPLv3) license, which can be downloaded from 15 

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/blob/master/LI16 

CENSE. 17 

 18 

  19 
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SUPPLEMENTAL FIGURES 1 
 2 
Figure S1. Graphlets and orbits configuration. Illustration of graphlets 3 

networks used in (Pržulj, 2007). Each graphlet configuration is labelled with Gn, 4 

in which, ‘n’ is the graphlets number (from G0 to G29). These labels match with 5 

the cellular motifs in (Fig. 1). Each vertex represents a cell and each edge the 6 

connection between two cells. Therefore, the graphs represent the connectivity 7 

network for each matched cellular motif. The three graphlets labelled in red (G20, 8 

G22 and G25) are the ones discarded in our work. The digits (from 0 to 72) at some 9 

mauve vertices indicate the orbits number counted for the GDD calculation.  10 

  11 
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Figure S2. Pipeline for the Graphlet degree Distribution agreement Distance 1 

(GDD) calculation. Scheme representing the protocol sequence to calculate the 2 

GDD between two segmented images: Eye and Diagram 1. First, a network of 3 

cell-to-cell contacts is computed defining the centroids of valid cells as nodes and 4 

its connections with neighbouring cells as edges. The nodes are represented with 5 

the same colour code as in Fig. 2. Second, the graphlets are extracted from the 6 

network. This enables the calculation of an index of the distribution of every 7 

graphlet. Finally, a comparison between the two Graphlet degree Distributions is 8 

performed to obtain the GDD value.   9 

  10 





 
21 

Figure S3. Comparisons between epithelia and CVTn path. 5-dimensional 1 

scatter plot representing every possible comparison between GDDH, GDDRV, 2 

GDDV5, percentage of hexagons and shape index. The X and Y axes for each 3 

chart correspond to its column and row names respectively. The CVTn path is 4 

shown starting at diagram 1 until diagram 100 (from 1 to 20, from 30 to 100 by 5 

steps of 10), and they are represented in greyscale beginning in black and 6 

reducing its darkness with the increase of the diagrams. A set of natural epithelia 7 

are display: cNT (16 samples, light blue), dWL (15 samples, green), dWP (16 8 

samples, red), Eye (3 samples, orange) and dMWP (3 samples, violet). The mean 9 

value is represented as a circle and their individual values as smaller 10 

circumferences. In the shape index column, values up to 3.81 represent solid 11 

tissues, painted in orange; shape index values greater than 3.81 indicate fluid 12 

tissues, in green. The histograms represent the dots density along each column 13 

of comparisons. These graphs complement Fig. 2. 14 

 15 

  16 
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Figure S4. Comparisons of the different simulations regarding the CVTn 1 

and natural tissues. All the possible combinations from GDDH, GDDRV, 2 

GDDV5, percentage of hexagons and shape index in 2-dimensional graphics. 3 

The CVTn path is shown starting at the diagram 1 until the diagram 100 (from 1 4 

to 20, from 30 to 100 by steps of 10). The average values of 20 replications per 5 

diagram, are represented as greyscale dots beginning in black and reducing its 6 

darkness with the increase of the diagrams. Images from biological samples are 7 

marked as dots representing their mean: cNT (16 samples, light blue), dWL (15 8 

samples, green), dWP (16 samples, red), Eye (3 samples, orange) and dMWP (3 9 

samples, violet); Simulations are represented with their mean (circle) and their 10 

individual values (circumference): Proliferative Control (20 replicates, carnation 11 

pink), Case III (17 replicates, hot pink) and Case IV (15 replicates, purple); Non-12 

proliferative control (20 replicates, blue bell), Squared (20 replicates, azure blue) 13 

and Elongated simulations (20 replicates, Cornflower Blue). In the shape index 14 

column, values up to 3.81 represent solid tissues, painted in orange; shape index 15 

values greater than 3.81 stand for fluid tissues, in green. The histograms 16 

represent the dots density along each column of comparisons. These graphs 17 

complement Fig. 3. 18 
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Figure S5. Shape index values for the analysed images. Plot with shape index 1 

and GDDRV as axes. The orange region represents the shape index values that 2 

define a tissue as ‘solid’, and the green zone as ‘fluid’. Circles are the average 3 

value obtained from the individual samples from the natural images: Eye, cNT, 4 

dWL, dWP and dMWP; CVTn (from diagram 1 to 100), Proliferative Control, Case 5 

III and Case IV; Non-proliferative control, Squared and Elongated simulations. 6 

Triangles stand for the average value from solid/fluid tissues: WT, (blue) and 7 

Mbs-RNAi (orange). 8 

  9 
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LEGENDS OF SUPPLEMENTAL FILES  1 

Movie S1.  A general example of the usage of EpiGraph. The movie shows all 2 

the functionalities of Epigraph and how to use them, in general terms. 3 

 4 
Table S1. GDD values between pairs of images from images of biological 5 

samples and Voronoi Diagrams. Graphlet degree Distribution agreement 6 

Distance mean between each row and column is shown. Data is divided by the 7 

used cellular motifs (Mo17 and Mo29). The used samples are Voronoi 1, 4 and 8 

5: 20 replicates; dWP: 16 replicates; dWL: 15 replicates; Eye: 3 replicates. 9 

 10 

Table S2. GDDs and percentage of hexagons of CVTn reference using all 11 

the cellular motifs sets. Data are distributed depending on the cellular motifs 12 

used (Mo7, Mo10, Mo17, Mo29). Mean and standard deviation of percentage of 13 

hexagons, GDDH, GDDRV and GDDV5 are shown, along with their associated 14 

diagram. 20 replicates of each diagram are represented. 15 

 16 

Table S3. Outlier detection results of natural images, simulations, rosettes 17 

and rigid/soft tissues. For the mean of each set of images, the closest diagram 18 

and confidence score are calculated (see Experimental Procedures, statistical 19 

analysis). In green, the confidence score above 0.95 corresponding to inliers. In 20 

red are marked the confidence scores below 0.95, which corresponds to outliers. 21 

 22 

Table S4. Measurements of fluidity from simulations and actual epithelia 23 

using the shape index. The shape index of all the tessellations used along the 24 

manuscript have been calculated in terms of the average of its median and mean 25 

values for each sample. The green colour is referred to a tissue with a shape 26 

index defined as fluid, and the orange colour is identified as solid. 27 

 28 
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